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1 Introduction to TACTIC

1.1 Introduction to TACTIC

What is TACTIC?

TACTIC is an extensible, web-based data and file management system. TACTIC centralizes the following aspects of digital
project workflow:

• Production data management

• Scheduling

• File (Asset) Management

• Communication

• Reporting

• and more

How does TACTIC work?

TACTIC manages two aspects of Digital Content Management: Project data and Files. TACTIC maintains both of these compo-
nents in one unified source.

Project Data Project data is stored in the
Database

Project Data is the information and lists that are
traditionally tracked in spreadsheets. TACTIC has the
ability to list all files you manage along with task
assignments, status’, and scheduling data, which can be
viewed in simple table formats or complex custom
reports. TACTIC eliminates lost email threads, missing
documents, and the need to update complex spreadsheets.
The "database" is the base location for all data. i.e. notes,
reports, schedules etc. What a database provides is a
central location for this information.

Content/Files Files stored in the File System Content refers to the actual files. When managing
assets/files the directory and file naming, along with
proper version control is what makes TACTIC unique.
Files in TACTIC are managed externally in a file system.
i.e. hard drive. The file server typically has a root assets
directory. From this location, TACTIC handles the
filenames and directories for that file system.

What can I do with TACTIC?

End-Users have various roles within a project or organization. The TACTIC interface can be moulded to provide each group
(department) with the ideal interface.

The TACTIC security architecture is a rules-based system where each End-User is provided with a login. The End-User is
assigned to groups determined by the project leader or administrator. These rules determine what the End-User has access to
within TACTIC.

Communication between groups and departments can be tracked in real-time by using the TACTIC Notes functionality. This
method eliminates lost email threads and misplaced documents.

TACTIC can manage limitless amount of tasks, the status of those tasks and the location of all files being managed. TACTIC
gives the End-User an accurate real-time understanding of how a project is progressing.

The table below illustrates how various End-Users may interact with TACTIC in a single organization.
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Content Creator The Content Creator often requires a view of all tasks assigned. The user can update a
status, check in and check out files, log work hours and communicate with Supervisors
using the Notes widget.

Supervisor/Manager The Manager/Supervisor is often required to schedule tasks, manage content and resources.
The project schedule can be adjusted in the User Schedule or Project Tasks view. The
TACTIC interface provides high level planning, communication and reporting tools. The
Supervisor often has access to all views which provides the ability to plan and adjust the
overall needs of a project quickly and easily.

Client Clients often need to review project material (documents, videos, images etc) and managing
this continuous feed of content is often a hurdle. TACTIC’s built in web technology allows
Clients to deliver files and provide real-time feedback without FTP or Email. TACTIC can
provide Clients with only the specific views and permissions needed for each project.

Executive Executives require a high level view of the project. This often involves building views or
"reports" that correlate data from all aspects of the project. TACTIC is able to provide cost
reporting, completion, efficiency and location of bottlenecks.

What can I do in TACTIC?

TACTIC is a transaction system allowing users to search, interact, update and report on project data and files. These interactions
are carried out using a few main operations:

• Search - Search query results are often displayed in a list where you can interact with your project data.

• Insert - Additions or "Insert" new data is often done at the start of a new project. This is done through various interface tools
like forms, multi inserts, CSV import and more.

• Update - Updating existing data is sometimes required. For example; updating a status, adding keywords, or changing an
assigned user. Specific views and tools also allow for selecting multiple items to edit at one time.

• Check-in - Part of TACTIC’s power is the ability to check in and manage your files/assets. When you do a check-in, TACTIC
versions and names the directories and files in your file server. Files remain organized and will never become lost.

• Check-out - When you need to work on some files that are already checked into TACTIC, you can check them out. This
process either points you to the where the files are located, or downloads them to your computer.

• Undo/Redo - Every action carried out within TACTIC can be undone. If a mistake has been made, simply undo the transaction.

How do I access the TACTIC interface?

TACTIC is delivered as a web site. This web based solution is extremely powerful because it allows for full interaction with
TACTIC and also direct integration with supported software packages.

Accessing TACTIC is as simple as visiting your server’s address (URL) in your web browser. For example:

http://yourcompany.southpawtech.com

Lets Get Started!

The following End-User documentation provides general usage of the TACTIC feature set. Additional information, tutorials,
forums and documentation is available on our TACTIC Community site:

http://community.southpawtech.com

2 TACTIC Start up

2.1 Setting Up Your Web Browser

Web Browser
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To access the TACTIC interface, a supported version a web browser is required.

To connect to the TACTIC server, type a URL in your web browser similar to the example below (the IP address will vary
depending on the network setup of your organization). An example is shown below:

http://192.168.14.198/

When you are connected to the server, you are presented with the TACTIC login screen:

Note
If you cannot see this TACTIC login, please contact your TACTIC Administrator.

Java Support

For certain transactions to occur between TACTIC and the client computer, Java will need to be installed. Currently TACTIC
supports: Java JRE 1.6.0+

To download the Java Runtime application, please visit:

http://www.java.com

2.2 Interface Map

When you log in to TACTIC from your browser, you will see a window similar to the following image. This section describes
some of the important parts of this window.
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1 - Header

1a Project
Homepage Link

The project bar shows the TACTIC logo and release. This link will also direct you back to
the project selection page.

1b Project
Thumbnail

This area shows the name of the project and thumbnail.

1c Project Selection
Menu

A drop down list to switch between projects.

1d Main Action
Menu

Main TACTIC Actions menu.

1e User Menu Allows for editing of basic user settings
1f Main Help Link Loads the Built in TACTIC Help (documentation, links etc)

2 - Sidebar

2a Project
Views

Project Views contains links to different views with information about the project as well as
workflow.

2b My Views My views is a collection of views that are custom created by the login user for personal use.
2c My Admin My Admin displays the Tactic system, as well as the project and adminstration schema. Access

to this part of the sidebar is generally reserved for admin level users.

3 - Main View Panel

3a Tabs Tactic supports loading multiple tabs, similar to how web browsers handle tabs. Views can
be loaded into tabs either automatically or through right-clicking on a link.

3b Simple Search In some views, a simple search will be included. The Simple Search option provides a quick
and easy way to search specifically within the current view in use.

3c View Toolbar In some views, there will be tools which are specific to the view. For example, the "Table"
view provides an array of tools for interaction with that table.

3d Main Panel The Main Panel is where the actual results of the view are displayed. This can be a table, tile
layout, dashboard etc.
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2.3 TACTIC Gear Menus

Top Gear Menu

Add

Add New sType Add a new sType to the schema.
Add New <. . . existing sType from schema. . . > Open a new tab and pop-up a window to insert a new item

of the existing sType from the schema.

Edit

Undo Last Server Transaction Undo the last transaction.
Redo Last Server Transaction Redo the last transaction.
Show Server Transaction Log Display the Transaction Log in a pop-up. The log holds all

the transactions since the creation of the project.

Tools

Web Client Output Log Load the Web Client Output Log. This log details TACTIC
output as well output from statements in scripts.

TACTIC Script Editor Load the TACTIC Script Editor pop-up.

Help
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Documentation Open a new page to TACTIC’s Documentation.
TACTIC Support Community Open a new page to TACTIC’s Support Site.

Gear Menu for the View

Edit

Retire Selected Items Retire the selected items. Retired items are hidden from the
view, but not removed from the database.

Delete Selected Items Delete the selected items. Deleted items are removed from
the database and are no longer available.

Undo Last Server Transaction Undo the last transaction
Redo Last Server Transaction Redo the last transaction
Show Server Transaction Log Load the TACTIC Transaction Log. The Transaction Log

holds all the transactions since creation of project.
Add Tasks to Selected Add tasks to the selected items.
Add Tasks to Matched Add tasks to the matched items.

File
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Export All . . . Export all of the item in the view.
Export Selected . . . Export all of the selected items in the view.
Export Matched . . . Export all of the Matched items in the view.
Export Displayed . . . Export all of the displayed items in the view.
Import CSV . . . Import a CSV file.

Clipboard

Copy Selected Copy the item that is selected in the view (indicated with a
check mark) to the clipboard.

Add Selected Add the item that is selected in the view to the list of items
already on the clipboard.

Paste Clipboard Paste the items from the clipboard to the current view.
Show Clipboard Contents Display the contents of the clipboard in a pop-up window.

View

Column Manager Pop-open the Column Manager.
Create New Column Pop-open the Create New Column Window
Edit Current View Edit the current view.
Save Current View Save over the existing view with the current configuration.
Save a New View Save the current view as a new view in the sidebar.

Print

Print Selected Print all the selected items in the view.
Print Displayed Print all the displayed items in the view.
Print Matched Print all the matched items from the search criteria.
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Chart

Chart Items Create a chart of displayed view.
Chart Selected Create a chart of the selected items.

Tasks

Show Tasks Add the Task Edit column to the view.
Add Tasks to Selected For the items that are currently selected in the view, add

tasks to them.
Add Tasks to Matched For all the items returned by the search, add tasks to them.

Notes

Show Notes Add the Notes column to the view.

Check-ins

Show Check-in History Add the Checkin History column to the view.
Show General Check-in Tool Add the General Check-in Tool as a column to the view.
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Pipelines

Show Pipeline Code Add the Pipeline Code column to the view.
Edit Pipelines Open the Workflow Editor in a new tab.

2.4 Internationalization

TACTIC supports international unicode characters for almost all elements in the interface. Mose elements in the interface accept
unicode character streams navtively. This makes it possible to customize a project in any native language.

The following show an image of using TACTIC in Japanese:

The following sections of TACTIC are capable of using unicode characters:

Notes

All notes, including the discussion widget and the notes sheet can accept unicode characters.

<show example here>

Data

Column Headers

<show example here>
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Side Bar

Pipeline

<show example here>

Limitations

There are certain areas where it is recommended to use Latin-1 characters. These sections may be able to use unicode characters
for certain uses, but areas have been found where these sections can cause issues.

• Project codes: project codes are used to generate the URL of the project and the database of the project. PostgreSQL ac-
cepts database unicode database names quite well but URL with unicode characters are not typically accepted or used. It is
recommended that project codes stay with alpha_numeric character set with underscores as a delimiter

• Search Types: search types are used to identify a type of sobject. These search types are often identified in code. It is not
typical to see unicode characters in code, although this may be changing as computers and languages support becomes more
ubiquitous. However, there are still many areas in computing where unicode characters are not supported and it is possible that
limitations will occur. The TACTIC interface and database generally accept unicode strings with issue.

• View Names: View names are stored in the database as XML. An example of this is as follows:

<config>
<xxx>

<element name="foo"/>
</xxx>

</config>

where "xxx" is the view name. Most XML libraries will accept tags with unicode characters, however, some do not support
them completely. This can cause issues when doing searches and xpath through xml documents. For this reason, it is recom-
mended to use alpha_numeric characters with underscore delimiters for view names. The view name does not typically appear
in the user interface for users, so this does not usually cause an issue.

2.5 Sidebar
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The TACTIC sidebar is the main menu system for navigating through the views in the TACTIC Project. The access rules applied
to a specific account determine the contents of the sidebar as well as which views are displayed when a user is logged in.

The items in the sidebar provide links to existing views within a project. These views are built by your organization’s production
manager based on a selection of columns (properties), layouts (order and column width) and a search. If a search view is
available, it provides a dynamic report based on the definition of the search.

The sidebar is divided into three different categories, "Project Views", "My Views" and "Admin Views".

The Project Views provides a way to save project wide views that everyone across the entire
project would want to see. It also has a manageable list of custom user views. The Project
Views can be defined by the person in the role of the project manager. Views can also be
hidden from specific user groups. My View contains a list of links to views that were created
by the login user themselves. These usually are created by the user to cater to their own
personal work flow.

Admin Views

Admin Views displays the project schema and the TACTIC system and administration schemas. Access to the Admin Views
section of the sidebar is generally reserved for admin level users.

My Admin - My Admin holds views that will allow the users to manage My Views and My Preferences.

Manage My Views Edits the views saved in the "My Views" section.
My Preference Preferences include: Debug, Web Client Logging Level, Color Palette, Language,

Quick Text for Note Sheet Thumbnail Size

You can add any view to the sidebar very easily. If you have a view open in a tab, you can simply right click on the tab and select
“Add to Side Bar”. This will add the link to the sidebar under the Project Views. This will allow you to customize the sidebar
and let you quickly open your important views which you use regularly.

Now, “My Dashboard” will be a link in the sidebar which takes you to this view. You can just as easily remove this link from the
sidebar by right clicking on the link and selecting “Remove Link”.
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3 Preferences

3.1 How to Change Your Password

1. Log in and go to the top right hand corner of the screen. The name of the current user logged into TACTIC session is
displayed here. Click on the button labelled "My Account". From the context menu, select "Edit My Account".

2. Type in the new password and re-confirm it in the following field.

Modify any other account information that needs to updated and hit Save.

4 Interface Usage

4.1 Edit

Introduction

The following describes how to edit the data in various views of TACTIC.
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Editing Using a Form

To edit a row of data, right click anywhere on the row and select "Edit" from the context menu.

A form pop-up to edit the data will appear. The description on the left side indicates what data to enter into the input fields.

Editing Inline

Clicking on a field within the row allows editability only if edit mode for that column is enabled.

Below is a few examples of edit modes for the various widgets:

The edit mode for the Text Widget is most common. This widget allows keyboard entries into editable fields.

The edit mode for the Selection Widget is displayed below. The widget restricts your input choices to the options in the drop
down selection menu.
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The edit mode for the Calendar Widget is displayed below. The Calendar widget pops-up a monthly calendar for convenient date
selection.

Multi-Edit

To modify the more than row so that they all have the same data, first check mark the rows to be edited.

Left click on a cell in the column to be edited. The row will go into edit mode.

Once the text is entered, click off the cell. All cells selected will have the same data.

4.2 Delete and Retire

Introduction
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TACTIC provides many ways to delete and retire items directly from the view. Retiring is TACTIC’s way of marking an item so
that it does not appear in any searches, but allows the user to bring it back if necessary. The methods to delete and retire an item
are described below.

Deleting from the Context Menu

To delete an item from the view, first put a check mark in the box next to the item you want deleted. Then, right click anywhere
on the row to bring up the context menu. Selecting the "Delete" option will delete the object from the view and from the database.

Deleting from the Gear Menu

Alternatively, the gear menu can be used to delete an item from a view.

1. Put a check mark in the box next to the item.

2. In the tool shelf and click on the gear to bring up the gear menu.

3. Selecting the "Delete" option will delete the object from the view and from the database.

Note
If an item is deleted by mistake, to undo this action, go to the top gear menu, select Edit → Undo Last Server
Transaction.

Retiring from the Context Menu

To mark an item as "Retired", first put a check mark in the box next to the item. Then, right click anywhere on the row to bring
up the context menu. Selecting the "Retire" option will mark the object as retired and filter it out from the view.



TACTIC End-User Documentation 16 / 59

Note
Items will still exist and can be brought back. The next section will shows how to view items that have been marked
as "Retired".

Retiring from the Gear Menu

To retire an item from the view using the gear menu:

1. Put a check mark in the box next to the item.

2. In the tool shelf and click on the gear to bring up the gear menu.

3. Selecting the "Retire" option will mark the object as retired and filter it out from the view

Note
The item will still exist and can be brought back. The next section will shows how to view items that have been
marked as "Retired".

Showing Retired Items

When an item is "retired", it has simply been marked as "retired" in the database. The item still exists in the database and can
be brought back. To show items that have been retired in a view, go the any column header and right click. This will bring up a
context menu. Select "Show Retired".
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Note
The items marked as "retired" appear highlighted in red.

4.3 Creating and Editing Views

TACTIC provides the following configuration display options when creating or editing a view:

• Which columns are part of the view

• The order of the columns

• The width of each column

• The Grouping of the items

• The Search which has been applied to the view

In TACTIC, there are 2 main distinctions between the types of views Project Views and My Views. These are presented in 2
sections within the main sidebar.

• Project Views - Project views are presented to all users in the production and/or can be hidden based on group access rules.
Project views are also generally only created by the project manager and the ability to save and modify them can also be
blocked with group access rules.

• My Views- My views are views saved per user. It allows for saving of personal views outside of the project views. These will
only be available to the user who created them.
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Adding Columns

To add a column, right-click on any column header in the view.

Select the Column Manager

In the column manager, selecting columns will add them to them current view. The sections in the column manager are as
follows:

• Custom Widgets - These are the custom widgets which have been defined for the current type. These represent both changes
to information (i.e.. switching a code) as well as tools which represent certain actions for that type (i.e.. a button which loads
the asset into an application)

• Common Widgets - These widgets are similar to the ones above but, are common to all types in TACTIC. They are tools
which are generally universal.

• Raw Database Columns - These are the raw data (property) columns which exist for the type. Generally, each is represented
by a Property Column but, this allows adding of the data in its raw format. For example, a task has start_date and end_date
database columns but, there may be a schedule column which displays the start_date and end_date together in a calendar
widget.

Note
Certain widgets require Java to be started up so, it can take a few seconds for the selected column to actually appear
in the view. When finished, click the close button.

Removing Columns

To remove a column from the current view, left click in the column header for the column to be removed and choose Remove
Column. Columns can also be removed through deselecting them in the column manager.
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Ordering Columns

To re-order columns, click and drag a column in the header to the desired location in the view. As the column header is dragged
to the left or the right, an orange bar will appear between the columns indicating where the column appear if the mouse button is
released.

Resize Columns

To resize a column width, hover the pointer over the divider between the column headers and the mouse pointer will change to a
width adjuster.

Left click and drag the width adjuster to change the width of the column.

Grouping

Some columns in TACTIC contain categorical data. Some examples include status, parent, assigned user columns. These
columns can be grouped.

For example, grouping by the Assigned User column displays the items in groups by each user.
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To apply grouping to a view, left click on the column header to be grouped and choose Group By

Search

The Search Tool is used as a filter to only display items which match a certain criteria. This allows the results in the view to be
narrowed down. When a view is saved, the search criteria is saved with the view which causes the view to become a live report
as each time the view is loaded the search filter will be applied to the live data.

For example, if a search filter is created which shows only items which have a child task with the status "Review", the view will
provide a report of all items which need to be reviewed. When the status of these tasks are changed, the items will be filtered out
and no longer appear in the view.
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Saving the View

After the display of the view have been configured, to save the view, go to the gear menu under View. The options are described
below.

• Save Current View - Saves over the existing view. (Available only to users with access to save project views. Otherwise, it
will save a new My View)

• Save As New "My View" - Saves the view to the user’s personal My Views. (Available only to users who can create views)

• Save As New "Project View" - Save a new project view which will be available to all users. (Available only to users with the
appropriate access.)

• Edit Current View - Opens up a pop-up window to edit the table and the columns.
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5 Searching

5.1 Search Interface

Description

The TACTIC Search Box is used to build filters to refine the results in the view. A variety of search filters can be constructed,
ranging from simple column searches to large complex compound searches. The creation of search filters closely resembles that
of creating mail filters in a mail application. Each search filter plays a role in the outcome of the final results. The Search Box is
flexible enough to handle any kind of search.

Keyword Search

Open the Search Criteria by clicking the button on the tool shelf.

The keyword search section allows for creation of a search filter to search on the words found in the column named keywords.
These keywords must be manually inputted and updated.

Filter



TACTIC End-User Documentation 23 / 59

The Filter section allows for the creation and activation of search filters. Each search filter operates on one attribute on that sType.
These searches use standard text search logic and supports TACTIC’s expression language.

The Clear button clears out all the data in all the search filters: resets the drop down selection boxes and clears out the input
search criteria box.

Parent Search

A search can be based on any property of a parent search type. For example, if asset_category is the parent type then a search
can be made based on the properties of the parent. For example, a filter can be created on the parent (asset_category) where the
code is "video".

Children Search
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The Children search filter allows refining based on data in columns in the children. For example, a filter can be created to find all
tasks where the priority is greater than 3.

Matching and Compound Searches

Click the [+] icon beside a search parameter to add additional search definitions.

The drop down selection box at the top of the search box can be used to set up the search to be match open (matching any of the
definitions) or match specific (matching all of the definitions). The default match option is "Match all".

Compound Search gives the capability to set an AND or an OR option for filters. The default compound search option is "AND".

To switch the compound search option, select "Compound Search" from the drop down selection box at the top, add a new search
filter, click on the word "and" that appears between the search filters to toggle it to "or".
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Operators

is Finds an exact match. eg. Process "is" Compositing
is not Finds all the results that do not match exactly. eg. Process

"is not" Compositing
contains Does a partial match. eg. Process "contains" ompost
does not contain Finds all the results that do not match a partial match.
is empty Match the empty field.
starts with Match on the beginning part of the string. eg. Process

"starts with" Comp
ends with Match the ending part of the string. eg. Process "ends with"

ing
in Match any of the strings delimited by "
". eg Process "in" Compositing Lighting
not in Find all the results that do not match the strings delimited

by "
". is distinct

The "In" Operator

It is possible to search for items in a list using a simple text string with a "|" operator. For example, search for either "TM_001"
or "TM_002" or "TM_003":

Sequence code [in] "TM_001|TM_002|TM_003"
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The vertical bar (a logical "or") is a delimiter that specifies that the search should look for any item with the code "TM_001" or
"TM_002" or "TM_003".

To switch the compound search option, select "Compound Search" from the drop down selection box at the top, add a new search
filter, click on the word "and" that appears between the search filters to toggle it to "or".

The "Is Distinct" Operator

This operator filters out items with the same column value. ie. The results will only contain items that have a distinct entry in
that column.

Sequence code [is distinct]

note: there is no need to put any criteria in the box when using the operator is distinct

Saving Searches
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When saving a view as either "Project View" or "My View", the search filters are also saved with the view. Once the view is
saved, the next time the view is opened, the search filters will be applied. This makes saving a view essentially like generating a
report with a predefined set of criteria.

5.2 Expression Searching

Expression values

The search criteria input for search filters can be TACTIC expressions. To signify to TACTIC that a search criteria is an expres-
sion, wrap the expression in curly braces {}. This signifies to the search engine to evaluate the value as an expression before
sending it to the search.

Having the search criteria be a TACTIC expression allows for many uses of predefined variables in the expression language.

For example, the following will search for all tasks for this week based on a Sunday to Sunday work week.

timestamp "is after" "{$PREV_SUNDAY}"
timestamp "is before" "{$NEXT_SUNDAY}"

Here is the TACTIC expression to find all of the checkins that have occurred this month:

timestamp "is after" "{$THIS_MONTH}"

Here is the TACTIC expression to find all the tasks for the current project:

project_code "is" "{$PROJECT}"

Note: the curly braces {} around these predefined variables are not needed in the expression mode described below.

Full Expression searches

Full expressions searches are an advanced way of searching for results. For each column, there is an "**expression" option. This
option provides the ability to use the full power of the expression language within a search that are beyond the capabilities of the
search user interface.

The full expression executes an evaluation on this expression then relates the results to the main search. Careful consideration
must be take to refine an expressions so that is as efficient as possible.

For example, search for all of the assets that have model tasks:

@SOBJECT(sthpw/task[’context’,’model’])

This search will first execute a search of all of the tasks that have model. Note that this does a search on all of the modelling
tasks. With a large number of tasks, this operation can be heavy. Care must be taken to minimize the results of the expression.
One way to make the search more efficient is limit the search to just that of the current project:

@SOBJECT(sthpw/task[’project_code’,$PROJECT][’context’,’model’])

The expressions can be combined with other filters in any combination so that very complex searches can be achieved.

For example, another more complex search is to find all items with a modelling task assigned to someone in the "toronto" location
(assuming there is a custom property on the login table), we can use:

@SOBJECT(sthpw/login[’location’,’toronto’].sthpw/task[’project_code’,$PROJECT][’context’,’ ←↩
model’])

This works because tasks (sthpw/task) and logins (sthpw/login) are connected through each other through the "assigned" column
in the task table and "login" column in the login table.

There are 4 modes available to the expression search: "have", "do not have", "match", "do not match". These four searches can
be applied to the Shot List page.
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1. Results "have" "@SOBJECT(sthpw/task)" will show all items that have tasks in them. This mode must return items in the
expression.

2. Results "do not have" "@SOBJECT(sthpw/task[context,model])" will show all items that do not have modelling tasks.
This mode must return items in the expression.

3. Results "match" "@COUNT(sthpw/snapshot[context,model]) > 3" will show all items that have more than 3 snapshots.
This mode must return True or False in the expression.

4. Results "do not match" "@COUNT(sthpw/snapshot[context,model]) == 0" will show all items that do not match the con-
dition where model snapshot count is 0. In other words, it means there is at least 1 or more model check-in for the shot.
This mode must return True or False in the expression.

6 Tasks and Schedules

6.1 Creating Tasks

Insert/Edit Tasks

There is more than one way to create new tasks. The following describes explains each way.

Task Menu

Select the item to add tasks to. Then, go to the Gear menu for the view and select Tasks→ Add Tasks To Selected.

Check mark the processes to add the task to and then hit Add Tasks.
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The skip duplicated option skips adding a task that has already been created for that process e.g. if only a task for design has
already been created.

Notice the new tasks added to the Task Pipeline column:

Another way to create a task is to create a task by context. This is provided in the drop down selection menu.

Create task by: Process Displays all the processes to select from, to create a task for.
Create task by: Context Displays all the contexts to select from, to create a task for.
Create task by: All
Contexts in Process

Creates all the contexts defined in the pipeline, but only displays the processes to select
from, to create a task for.

Task Edit Column
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The Task edit column can be used to insert tasks one at a time for a particular item.

Task Status Column

Once an item is created which has a pipeline, the widget will show a green insert button (+). This will load the task creation GUI
to create tasks for the item.

Task Properties

Each Task can have the following attributes.

Process The currently selected process. Use the menu to select a different process to perform on the current
parent asset.

Description A description to identify the task.
Milestone Assignment to a milestone item that represents a specific milestone in the project.
Status The status of the currently selected task pipeline.
Assigned The user assigned to complete the task.
Supervisor The user assigned to supervise the task.
Priority The priority level of the task.
Bid start date Proposed date to start the assigned task. Drag the date in the calendar to set.
Bid end date Proposed date to complete the assigned task. Drag the date in the calendar to set
Bid Duration Proposed amount of hours to complete the assigned task.
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7 Notes and Communication

7.1 Notes Widget

Introduction

The Notes Widget provides the ability to add a note directly to an item in the view. The notes are tracked in chronological order
and and are also grouped by process if entered against tasks. Other conveniences provided in this widget is the ability attach files
and to CC/BCC extra email addresses when you submit the note.

Adding a Note

If the Notes widget is not in the view, it can be added through the Column Manager.

To add a note, go to the Notes column and click on the plus sign in the top right corner.

The "For process:" drop down allows you to select the pipeline process to add the note to. If there is no pipeline for the item,
then a default process will be used for the note.

The Submit button will save the note to the item.

Additional Note Options

To attach a file, click on the Attach File(s) button. The file browser will open to prompt to select a file.

Additional fields to input Cc or Bcc email addresses can be found at the bottom, under Mail Options.

Note
If Notification Triggers have been set up in the project, emails will automatially be sent to the appropriate users
when notes are added. Adding a CC email address to a note simply sends the note to the email addresses regardless
of Noification Triggers.
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Multiple Notes

When multiple notes are saved to an item, the interface will look like the following (notice that the notes for the item are
conveniently categorized by process):

Collapsed

Expanded

7.2 Note Sheet

Introduction

The Note Sheet widget provides a convenient layout for typing in notes for different processes in one concise user interface. The
Note Sheet is also built to provide rapid interface for entering notes. For example, the Note Sheet helps in daily review sessions
where the ability to enter notes in rapid succession is necessary.
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Description

Notes can be entered for any item. When the Note Sheet widget is added as a column, by default, the pipeline processes are used
as the processes for note entry. The processes for the example item shown in the screen shot above include design, final, rough
and delivery. The Notes Sheet widget allows entering of many notes in different processes and different parents at the same time.
They can be saved either individually or altogether. The private check box option make a note private.

Usage

When the Note Sheet is expanded, it may require that the processes be selected to display. At the top of the widget is a button
which allows you to load a process selection pop-up which exposes the desired processes.

After you are finished with note entry, you will two buttons appearing on the top right corner. Clicking on "save" will save all of
the notes. If you have the Note Sheet Widget opened for vehicle001, vehicle002, and vehicle003, clicking on the standard save
all will save all new notes in the view. To save one note at a time, there is also an individual "save" button for each process.

Clicking on the history button pops up a window which displays all the note entries under this particular context.

Private Notes

The private check box turns a note access to private if checked. The private option is a built in access rule which can deny a
group of users from being able to see notes flagged as private.

Note
Note - When using the Note Sheet on items such as Tasks, Notes and Snapshots, the default assumption will be to
add a note to the parent item for the particular process. For example, if adding a note to the "design" task, a note will
be added with the same process.

8 File Management

8.1 General Check-in

Introduction
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The General Check-in widget provides interface to do many of the most common kinds of check-ins used in TACTIC. It is a
highly configurable widget that allows a project to have customized check-ins for any part of the content creation process.

Check-ins are the ability to in TACTIC to take files that have been created and submitting them to TACTIC’s central repository to
be organized, stored and versioned. TACTIC has a comprehensive ability to track files and their histories with the added benefit
of enforcing naming conventions.

The general check-in widget can handle:

• Single Files - An image, video, document, etc

• Sequences - Commonly image sequences

• Directories - Full directories including files and sub folders

• Complex packages - Handling of a project source including project and source medial files.

Interface

The interface below shows a standard example of the General Check-in widget.

Tool bar

The tool bar contains a number of use functions.

Refresh Refreshes the whole widget and will also rescan the sandbox for any changes.
Browse to working folder Allows the user to browse to a new location for the working area.
Set to My Documents Sets the working area to the My Documents directory
Set to Desktop Sets the working area to the Desktop directory.
Browse Allows the user to select file(s) or directories to check in directly.
Set Sandbox Set the sandbox automatically based on the naming conventions. This makes setting up a

workspace very easy and organized.
Check-out tools Tools to assist in Checking out files. Described in the section "Check-out" below
Explore Sandbox Opens up the folder directly on the users computer. This allows for the quick copying

and pasting files into your sandbox workspace.

Process Select
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Check-ins for an item are always classified by a processes. TACTIC organizes all of the check-ins with various processes that
are defined for that item. The current process can be selected by the process selection drop-down. This often times corresponds
to a task assigned to that user for that process.

This will only show up if a pipeline has been defined for the item. If no pipeline has been defined, then a default process called
"publish" is used.

Often this selection will be locked because it is associated with an assigned task. A user will often work from a task also
associated within a particular process and then choose to check in files based on content created from this task.

Sandbox Area

On first load of a new task (process) the check-in widget will assist the user in setting up a work area.

The user experience protocol will determine how the user leverages the features in the sandbox. The recommended approach is
to allow TACTIC to create a sandbox location for the current process. This method is beneficial because it helps the user organize
work-up files before they are even checked into the server. This approach is recommended because it creates an easy accessible
and well organized file system on the users computer. It is however, possible to check in files from another location on the file
server using the browse buttons in the tool bar.

During the content creation process, users will create files and save them under this sandbox folder. All files associated with
this item should be stored here. It should be noted that this sandbox work area is not strictly enforced and it is easily possible to
navigate to other folders to check in files to a given asset. However, it is considered good practice to have user’s create files in a
well defined location in order to more easily manage overall disk space usage.

Any files created in the sandbox area will be display in this section. If any new files have been created and are not reflected in
the interface, then a simple refresh should make these new files appear.

Files that have been checked-in will show a small indicator in the icon to the right and will be colored in blue. The small indicator
will either be a green check mark, which indicates that the file in the sandbox is identical to the checked in file. If the indicator
is a red exclamation mark, this means that the file has been changed and is different from the checked in file.

To select all files in the sandbox area check off the "Select/Deselect All" check-box on the top right hand side.
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To quickly select all changed files, click on the arrow to open up extra menus and select "Select Changed Files".

All files that have been changed since the last check-in will be selected. TACTIC will remember the last subcontext checked in
for this file so. This allows changed files to be easily rechecked in when changes have been made.

Clicking on the right mouse button of any file will open up a context menu.

The following actions are available:

Open File Open the file using the application as set up by the client operating system.
Delete File Permanently delete the file from the sandbox area (and on the computer).
Properties Open up a pop-up showing the properties of this file, including all past check in information.

An example is shown below:

Check-In

When any files are ready to be checked in, they can be selected. The row will highlight for all selected files, and either a selection
list, or a text box will appear on the right side. Since many files can be checked into the same process in an asset, this provides a
sub-category to organize checked in assets (this is known as the subcontext of the context of a check-in). By default, this should
read (auto) which means that it will be automatically filled in.

When all of the files that need to be checked in have been selected, the check in widget will be enabled.

It’s good practice to add a note in the Description field while performing a check-in. This is important so all project users
understand why a particular check-in was made, and where it’s located.

When the "Check-in" button is pressed, all of the selected files will be transferred to TACTIC’s repository. There are a number
of ways that the files can be configured to transfer files. When TACTIC checks in a file, it will move them to the correct folder,
version and rename them to the correct file name as specified for the naming conventions.

Check-in Subcontext types

When checking in, a drop-down is available beside each file or directory. This functionality allows control over how each check-
in will be handled. This type of control is called subcontext. This can be looked at as a sub process for the sub-directories
included in a check-in.
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Auto

The "Auto" mode is used if it’s desired to keep file names the same as they are before the check in . This work-flow is beneficial
if one wishes to keep file names, or work in a situation such at subversion where files are constantly overwritten and versions are
handled automatically in the background.

Sandbox SANDBOX/project/assets/asset001/design/original_file.jpg
Check-in [multiblock cell omitted]
Check-out SANDBOX/projcet/assets/asset001/design/original_file.jpg

Main

If only one file/directory/sequence is going to be checked-in, it will also be re-named correctly by the naming conventions. This
is often the case when files are delivered to another department or the client.

Sandbox SANDBOX/projcet/assets/asset001/design/original_file.jpg
Check-in SERVER/project/assets/asset001/design/asset001_design_v001.jpg
Check-out SANDBOX/projcet/assets/asset001/design/asset001_design_v001.jpg

Text

If more than one file/directory will be checked in and strict control is required for each item, the subcontext will be different each
time a check-in happens. This often applies when different variations of a check-in are required. For example a blue and a red
version of a file might be needed for a particular check-in, so the user would type this in for each file:

Sandbox [multiblock cell omitted]
Check-in [multiblock cell omitted]
Check-out [multiblock cell omitted]

List

If more than one file/directory will be checked in and strict control is required for each item, the subcontexts are the same every
time a check-in occurs. This often applies when there are multiple sub-directories that need to be worked on for a task. For
example, a preview, project file and a directory of media files would be organized by selecting preview, project or media in the
drop-down.

Sandbox [multiblock cell omitted]
Check-in [multiblock cell omitted]
Check-out [multiblock cell omitted]

Note
Often these options are predetermined by the pipeline configuration set up by the TACTIC administrator. Other
combinations file/directory naming and file version control can also be configured through naming conventions.

Check-out

When working on a particular task that is part of a pipeline, files may need to be checked out or "downloaded" to be worked on or
revised. TACTIC assists with this process and allows easy access to retrieving the right files/directories from the TACTIC server.

Check-out Options
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A specific version can be checked out through the Check-out button in the History area. There are also more advanced options
available in the Check-out options menu.

Check-out w/ Source
Name

Check out the latest version of different contexts based on the original file name that was
checked in regardless of naming conventions.

Check-out w/ Repository
Name

Check out the latest version of different contexts using the repository names as seen in the
TACTIC repo.

Check-out w/ Versionless
Name

Verisonless check-ins only - Check out the latest versionless of different contexts using the
the versionless convention as seen in the TACTIC repo.

History

This area shows the check-in history. By default, this information is collapsed but can be accessed by clicking on Check-in
history.

8.2 Insert

TACTIC provides many ways to insert new items. For the beginner, insertion of a new item can done through a form that guides
you through each input field. For the more advanced used, insertion of an item can be done directly inline in the view. The
various methods to insert items are described below.

The insert button is on the tool shelf. It is the button with the green circle, with a white plus sign inscribed. Clicking on the button
bring up a form to guide you through each input field. The down arrow triangle next to the button allow you to do the insert in
different ways.

Each option of the Insert menu is described in detail below.

This insert menu option adds a new row directly into the page that you are viewing. The advanced user would be more comfortable
using this method.
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Once in this insert mode, refer to the column headers as a guideline as to the type of data to enter into the input field.

All input fields are optional. If no data is entered into an input field where one would be required, such as Code, an appropriate
default will be automatically generated.

note: Hitting the green plus sign will insert multiple rows into the view. This facilitates inputing data for multiple new items
quickly.

This menu option open a window which guides you through the data to enter for each input field. This method of inserting an
item is a good place to start for the beginner.

Once the insertion form pops up, the description on the left hand side can be used as a guide as to the type of data to enter into
the input field.
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All input fields are optional. If no data is entered into an input field where one would be required, such as Code, an appropriate
default will be automatically generated.

This menu option opens Multi-Insert the pop window.

The Multi-Insert pop-up window, allows you to add the same item multiple times.

The most important value that must be entered is one for the Multiplier field.

The number entered into the Multiplier box determines how many items that will be created.

Sequence code will determine which sequence the items will be placed under.

The Code value will be incremented by the value that is entered into the Multiplier.

*Note - The value for Code must start with a letter.

All the other values are optional.

8.3 Multi-insert

The Multi-insert option is located within the table views gear menu, in the edit option.
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The idea of a multi-insert is to be able to duplicate SObjects. Here is an example of a multi-insert view.

The most important values that must be entered are the Multiplier, and the Code.

The number entered into the Multiplier box determines how many SObjects that will be created.

Sequence code will determine which sequence the SObjects will be placed under.

The Code value will be incremented by the value that is entered into the Multiplier.

*Note - The value of the Code must start with a letter.

All the other values are optional.

9 Time tracking

9.1 Tracking User Work Hours

The TACTIC system has built-in work hour tracking, which can be tracked per task or work hours can be entered manually.

By default, hours can only be submitted to a task by the user that task is assigned to. For example, if an asset has a pipeline
process called "texturing" and this process is assigned to the user Albert, then only Albert can log work hours for this task.

Users log work hours in a task view with the "Work Hours" column.
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Hours can be logged and edited per day, per task.

To view the logged hours, go to the Work Hours view. (This view shows the hours for the user currently logged in.)

In the Work Hours view, you will see an item per time entry with totals per day and per week based on hours logged on all assets.

To manually track work hours for other events (for example, daily meetings), click the insert button and fill in the options in the
pop-up window:

Options

Login The login (user) who the hours are for.
Day The day the hours are for.
Category The category of work the hours represent.
Description A description of what the time was spent on.
Straight Time The amount of hours for the entry.
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9.2 Gantt Widget

Description

The Gantt Widget displays a horizontal bar graph representing the item’s start date, end date and duration. The bar graph can
be clicked on and dragged to manipulate schedules for projects and task schedules. The widget has 2 view modes: weeks and
months view.

Usage

*View modes:*Toggle the Gantt Widget between the 2 viewing modes by double clicking on the column header.

view mode: months

view mode: days

Start/End Date: Modify the start and end dates by left clicking and dragging them.

Hover Pop-up: Hover the cursor over the horizontal bars to pop-up a window that displays the dates of the schedule.

Shifting the bar: Click dragging the bar shifts the start and end dates bar while maintaining the duration.

Multi-selection Edit: First, check mark the items to be modified.

Adjust multiple start dates: With multiple items selected, click drag on one of the start dates to adjust all the start dates
simultaneously.

Adjust multiple end dates: With multiple items selected, click drag on one of the end dates to adjust all the end dates simulta-
neously.
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Shift all the bars: With multiple items selected, click drag on one of the bars to shift all the start/end dates simultaneously while
maintaining the duration.

Shift the view: Click drag on an empty area of the Gantt Widget to the mouse left or right. The bars and the units will shift while
maintaining their values.

Scale the view: Hold down the shift key. Then, click and hold on an empty area of the Gantt Widget and drag the cursor to the
left or the right. The bars and the units will scale while maintaining their values.

9.3 Charting

Tactic includes supprt for charting views in your project in different charting formats. These charts supply visual representations
of your data for use in reporting, statistics and data comparisions.

The various types of charts available are:

Line

Bar
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Bar3D

Some notes about charting

When creating a view to be charted, it is important that the view includes columsn which provide numerical based data. This
data is required to allow the chart to draw correctly.

You are able to have multiple data values on the data axis of the chart. For example if you have a view of assets and want to
iclude statistics on the total snapshots, total notes and total tasks the chart will be able to include all three.

Generating Charts

1. First create a view you wish to chart, in this case we will be using a file usage view. This view shows the Mb usage and
snapshot count for all of the assets in the project.

2. In the table gear menu, there are 2 options: * Chart items - charts



TACTIC End-User Documentation 46 / 59

all items in the system for the particular Search Type (in this example assets) * Chart selected - charts all selected items
in the view.

3. In the gui, a chart will be generated with the assumed y-axis column
being code and the x-axis being all other columns in the view. The setting for the cart can be further tweaked in the Chart
specifications.

Chart Specifications

search_type The Search Type the chart is being generated for.
chart_type The type of chart to generate. See the chart types below.
Y Axis The column to use for the y-axis
X Axis The column(s) to use for the x-axis
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Saving Charts

Currently Charts cannot be saved. This will be included in a future release of Tactic.

Advanced

Axis Expressions

The charting Gui supports using expression directly for the x-axis. To do so:

1. In the chart specifications, hit the (+) to add a new x-axis value.

2. In the text field provide an expression. For example {@COUNT(sthpw/note)}

3. Refresh the chart and the expression will be evaluated as a column.

9.4 Tasks Quickstart

After inserting a new item into a project, often the first things to do is to create a new task, assign it and have the appropriate user
work on it.

1. Load any view of items you wish to track tasks for.

2. If the task status edit column is not
in your view, you can add it with the column manager or switch the Layout to "Task Schedule"

3. If no tasks exist, click the (+) icon
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in the task status edit column. Another option is to select the items and choose Tasks→ Add Tasks to Selected from the
Gear Menu. Both approaches will load the task insert pop-up.

For now, click create tasks to create tasks for all process available in the pipeline.

Note
If a pipeline has not been set up for the particular sType you will not see any processes available in the UI. This
will require building a pipeline which is covered in the TACTIC Setup Documentation

2. Once tasks are created, you will be able to assign them to users, assign dates, priority etc.
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10 Importing and Exporting

10.1 Exporting CSV Data

Description

TACTIC uses a database and thus naturally exports to table-based outputs. TACTIC includes a simple user interface to export
any table-based view out to a CSV file (Comma Separated Values file). Data can also be edited and imported to update or create
new items in TACTIC.

Exporting Data

To export data from a TACTIC view to a CSV file, first check mark the rows to export. Then, go to the gear menu and under File
select one of the following options:

Other export options include

• Export All - All items in the database

• Export Selected - Only the selected items in the view.

• Export Matched - All items found by the search

• Export Displayed - All items in the current view.

Next, select the columns to export from the selection list and click the Export Selected button.
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Note
Only columns saved to the current view will be available foe export. It may be ideal to save a view particularly for
exporting which includes all desired columns.

Depending on your web browser settings, the web browser will prompt to open or save the file.

Below is an example of the contents of the resulting CSV file:

"id","preview","title","keywords","description","asset_category_code"
"1","","Nuclear Explosion","explosion, fire, nuclear, bomb","Stock footage of a nuclear ←↩

explosion","video"
"2","","Car Chase","car, chase, fast, race, map","Stock footage of a overhead car chase."," ←↩

video"
"3","","Car Warehouse","car, warehouse, dark, headlights, exterior, engine","3D Car asset ←↩

in a warehouse setting","3d"
"4","","Sport Car Warehouse","car, warehouse, interior, dark, headlights, engine","3D Car ←↩

sport car","3d"

When the CSV file is open in a CSV-compatible spreadsheet application, you will be able to easily manipulate and add data:
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10.2 Importing CSV Data

Data can be imported into TACTIC and associated with the appropriate columns. Since TACTIC is based on a table system, data
can be exported as a CSV file for easy manipulation in a spreadsheet program.

Note
For more information on exporting existing CSV data, go to the section, "Exporting CSV Data."

To import a CSV file:

1. Go to Gear Menu→ File→ Import CSV . . .

2. Select an sType or copy and paste the data from a spreadsheet. Once an sType is selected, the required columns will be
displayed to the right of the drop down. Although these aren’t the only columns that can be imported for this sType, they
represent the minimum requirements for a successful import.

3. Browse and upload the CSV file. The CSV file is the raw format required by TACTIC. Below is an example of the contents
of a CSV file:
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"id","title","description"
1,"Nuclear Explosion","Stock footage of a nuclear explosion"
2,"Car Chase","Stock footage of a overhead car chase."
3,"Car Warehouse","3D Car asset in a warehouse setting"
4,"Sport Car Warehouse","3D Car sport car"
5,"Robot Bar","Robots drinking in a bar"

Below is an example of a CSV file being manipulated in a spreadsheet application.

4. Click the Upload button. The TACTIC system will introspect the CSV file and fill in the rest of the import interface.

5. Parsing Options
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Use Title Row When checked, this import will read the first row in the file to determine which
item columns are being imported.

Sample Data Row Specify a row in the file to use as a sample for the data import.
Encoder Select the encoding format for the data: ASCII (default), UTF-8, Excel ISO

8859-1
Identifying Column Select the column which unique identifies the corresponding row in the table to

update the data with.

6. Import
The bottom of the page shows a preview of the import results. Hitting the Import button will start the CSV import.

11 Clipboard

11.1 Using the Clipboard

Introduction

The Clipboard menu feature provides an easy method for transferring items (row data) from one view to another. Items can also
be copied between different projects. This feature can be used similarly to the copy and paste function that we are familiar with
in most applications.

The Clipboard Menu Options

The features for the Clipboard can be found on the tool shelf under the Gear menu→ Clipboard.

The individual options of the Clipboard menu are described in detail below.

Copy Selected

This menu option copies the items to the Clipboard that you have checked marked in the view. Either one row or multiple items
can be copied. Once the items have been copied to the Clipboard in memory, the destination view has been navigated to, to allow
pasting the items.

Note
The Clipboard has been built with the ability to copy and paste items from one project to another.
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Add Selected

This menu option copies the items that have been check marked and adds them to the items that are already have on the Clipboard
without wiping out what is on the Clipboard. This menu option is useful especially when navigating through different views to
gather row data.

Paste Clipboard

This menu option pastes the items that have been stored in the Clipboard into the view.

Note
Regarding copying and pasting to another project and the History column: After pasting the contents of the Clipboard
to the view, the latest History of the item’s check-ins will refer to the item under the original path where the files
live. The paths will point to the item in the new project as soon as the first check-in transaction is completed for this
item under the new project.

Show Clipboard Contents

This menu option opens up a pop up and displays the items that are currently stored in your Clipboard.

12 Transactions

12.1 Undo Your Actions

Similar to most software applications, TACTIC provides a convenient way to undo an action. Almost every action in TACTIC
is undo able. Transactions can include changes made to the database and to the file system (for example: check-ins). One major
benefit with TACTIC transactions is that they are not scoped to just your current session. If you close down Tactic and log in a
week later, you can still undo your last transaction.

The Undo action can be found by clicking on the top gear menu and choosing: Edit→ Undo Last Server Transaction

To see a list of the transactions which can be undone, click Show Server Transaction Log. (This log contains only those actions
completed by the user who is currently logged in.)
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Notice the drop down selection menu provides a way to filter the transaction list by time.

To reverse the transactions directly from this log, click Undo to undo the most recent transaction in the log. Continue back
through the log, undoing one transaction at a time until the transaction to be undone is reached.

When a transaction is undone, it is relabeled with the type "redo" in the "Type" column. The original action can be performed by
clicking on the Redo button.

13 Glossary List

13.1 Context

To allow for separate versioning of files within the same SObject (container) during checkin, TACTIC uses "versions" and
"contexts." Snapshot data always includes this information.

Contexts define a separate "channel" for checking in files. For example, one SObject may require separate files to be checked
in for different tasks. For example, in the following list one drawing file is checked into a single SObject with both "rough" and
"final" contexts (and with multiple versions). In this case, the contexts represent files checked in for both the rough and final
processes (tasks).

/assets/myProject/drawings/drawing_001/drawing_001_rough_v001.png
/assets/myProject/drawings/drawing_001/drawing_001_rough_v002.png
/assets/myProject/drawings/drawing_001/drawing_001_rough_v003.png
/assets/myProject/drawings/drawing_001/drawing_001_final_v001.png
/assets/myProject/drawings/drawing_001/drawing_001_final_v002.png

13.2 Searchable Object (sObject)

SObjects in TACTIC are not actual physical files, but instead they are descriptive containers that store all the information neces-
sary to define an object and track it. If the definition of the Search Type permits, an SObject can contain relationships to child



TACTIC End-User Documentation 56 / 59

SObjects. Separate SObject children can be used to store extra data. For example, they could be "task" SObjects set up based on
the pipeline to track approvals and notes, or they could be "snapshot" SObjects that store file checkin and location information.

In a project, an SObject can be used to store the production data for any digital asset requiring multiple associated files. When
you create a new SObject, you must create it based on a Search Type (for example, the "model" Search Type). When you insert
this new SObject, you are simply inserting a new entry into the "model" Search Type’s library. Based on the associated template
Search Type, the new SObject will require specific data to be inserted. For example, a name, description, pipeline code and so
on.

13.3 Retire

At times you may wish to offline an Search Object but, not remove it from the system. Every search type has a s_status preperty
that when set to retired hides the SObject but, makes is easy to reactivate it.

13.4 Sidebar

Views provide users with what they need to see and how they need to see it. The are collections of different Search Type
properties which are relevant to a team members role in Tactic. Views are mainly accessed through links in the sidebar either as
Project Views which are configured for the whole production (but ca be controlled with access rules) and My Views which are
views a uses saves as their own personal views or "bookmarks". Views can also contain a saved search which, provides a view
as a live report.

13.5 Project Workflow

Pipelines define a hierarchical set of processes that lay out all of the production and approval steps an SObject must go through
before being completed. It is important to note that each process contains its own set of approvals (task pipeline). Typically a
process must be completed before it can be handed off to the downstream process or processes. TACTIC uses pipelines in this
manner: when a process is approved, the next downstream processes receive the green light to start.

13.6 File System

When files are checked in to TACTIC, they are passed through the directory and file naming conventions. This relieves the user
of the responsibility of figuring out where to place files on the server and what to name them. Naming conventions are defined
using the "naming" Search Type, which stores an expression used by TACTIC to generate the location and name for a file upon
checkin.

13.7 Query

A query into TACTIC is a request to retrieve Search Objects from the database. In the Tactic interface when a user searches for
something, they are doing a query.

13.8 View

Views in the TACTIC interface are built using a "Table" widget that is defined based on a Search Type. Views can be configured
to display specific properties (columns) and also the widgets (tools) that are used to display them.

Views can also be filtered to control which SObjects are displayed with search tools. For example, search tools can create reports,
or views summarizing which SObjects are at which stages in the pipeline. Views and reports can be saved as either project views,
visible to multiple team members, or as personal views, visible to individuals ("My Views").
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13.9 Note

13.10 Event

The TACTIC system is based on events, and every interaction with any SObject is tracked. Events may include changing a status,
adding a note or checking in a file (to list but a few examples). Every event is logged into a transaction log, and can be undone.
The transaction log is very valuable because it enables easy tracking of when something happened and who did it.

An event can also execute another event in the system (or a "trigger"). Triggers are set up as custom scripts which can be
configured to do almost anything in TACTIC through the TACTIC Client API. Example uses of triggers include changing the
status of another task SObject, checking in additional files, or executing an external rendering application.

13.11 Access Rule

When configuring TACTIC, it is important for both security and simplicity to set up appropriate access rules. Access Rules are
typically applied to user groups, making it easier to control what different groups of users or departments can access in TACTIC.

13.12 Project

A TACTIC project defines a real-world project or separates one of its timelines. Each TACTIC project has its own separate
database and structure. Projects are the highest level separation in TACTIC. They represent a separation in workflow, Searchable
Types, Views, Access Rules, Naming Conventions Pipelines and more

Custom TACTIC projects can be built from the ground up to manage specific types of objects, processes and files. Alternatively,
predefined, ready-to-use TACTIC project modules are available to expedite the setup process and provide custom integration
tools appropriate for the project type.

13.13 Update

When you update an existing Serch Object in Tactic, this is called an update. For example if you change the description property
(column entry), saving the cnages commits an update to the database.

13.14 Snapshot

A snapshot describes an asset at a particular point in time. This description is sufficient to reproduce the asset completely at that
point in time. TACTIC has its own XML description language to completely define assets and their dependencies to other assets.

A snapshot can contain any number of files. For example, in a Flash production, a typical checkin will result in 4 files: a .fla (the
flash file to work on), .swf (a viewable file), and 2 pngs which represent a small icon and a large viewable image.

Every time something is checked in, a new snapshot is created of the asset. Snapshots can reference other snapshots, which
allows TACTIC to define dependencies to other assets or other snapshots of the same asset.

13.15 Searchable Type (sType)

Within a project, there are many types of objects to manage, and each object type requires different properties and types of files
to be stored. TACTIC uses Search Types to categorize the many types of objects that can exist in a project. Search Types are
templates that determine how these objects are defined and handled. Views, pipelines, naming conventions, access rules (and
more) are all defined based on assignment to a Search Type.

The basic architecture of the TACTIC system is built around interaction with objects through their Search Types. These objects
or "instances of a Search Type" are called Search Objects or SObjects. The TACTIC interface is simply a layer of widgets (tools)
delivered through a web browser that are provided for the user to search for SObjects, display them, and interact with them based
on their Search Types.
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13.16 Delete

Deleting a Search Object revoves it from the database completely. Although undoable, this is only right after doign so. If you are
unsure, retiring is ofter a good choice.

13.17 Task

A task is any job that occurs within a process, and is the fundamental atomic work element in project management. For details
on tasks, go to Working with Tasks.

13.18 Notification

Notifications are triggers built to execute on specific configured events, and can be internal to TACTIC (notification SObjects),
or even emails sent externally. Notifications can be configured to run based on rules that define the conditions that must be met
in order to send out a message. Conditions help to streamline who receives a notification for a particular event, as well as the
conditions specific to the event.

13.19 Trigger

Triggers are specific tools and scripts that are executed based on events which occur in Tactic. Within the project setup, there are
tools which help setup triggers and notifications with simple tools. Although if required, these Triggers can be quite complex.
Using the TACTIC Client API, you can achieve almost anything. For example, a trigger can be called when a task’s status is
changed. This type of trigger would first check what the status was changed to, and then only proceed to carry out a set of tasks
if the status was, for example, "approved". This may be as simple as changing the status of another task or as complex as loading
the final checkin for that task, render it to a video file and then check it back into TACTIC.

13.20 Checkout

Checkouts in Tactic is when a user requests a particular snapshot. This request from the users standpoint can simply be a request
for the current material which prompts TACTIC to deliver all of the files as well as any other dependant files to the user.

There are 2 ways for a user to actually retrieve the files for a snapshot.

1. The files can be loaded directly from the filesystem/fileserver. This way, the files are not copied to the users machine, they
are left where they are and simply loaded up. For this to work, you would have to have direct access to the Tactic assets
directory but can be more efficient as the files are not moved.

2. The files can be downloaded to the local sandbox where a user can work on them and save files however they like then
when ready to commit a checkin, do so through Tactic. The sandbox is good in situations where the user is either off-site
or there may be bandwidth issues opening the files directly.

13.21 Pipeline

Searchable Type metadata may also include a "pipeline_code" property to link the SObject to a pipeline SObject. In this event,
task SObjects are also created from the pipeline’s processes to define the processes the SObject will pass through as it progresses
through its production. When tasks (processes) are defined, they ensure that an asset can only move along the pipeline with all
checkpoints complete. For example, they can determine that the assigned user checks in files, generates notes, sets task status
and receives management approvals. After all of the associated tasks for the SObject are approved and it is packaged up and
marked complete, its production history information, files, and data are all still available as a package.

13.22 Process

A process is a definable phase in the pipeline of an asset. Processes require some type of delivery upon completion, and often
require that an asset be checked in as part of the delivery mechanism. A process is typically assigned to one person or one
department. For large projects, a single department could be assigned many processes.
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13.23 Project Schema

The project schema defines the hierarchy between Search Types in TACTIC. The schema definitions are stored in a "schema"
SObject which stores the parent and child relationships between the various Search Types in the project. The schema is automat-
ically updated when search_types are created in TACTIC, and can be modified in a schema view.

Searchable Types define how you want to manage your objects and also define a separation in pipelines, views, checkin methods
and more. They are some of the most important configuration aspects of TACTIC. The majority of the TACTIC architecture is
built around the use of search types for the needs of the project as well as many of the system level aspects.

13.24 Sandbox

The location on your workstation storing the files you are currently working on.

13.25 Insert

When creating new Search Objects in your project, you are effectiavely inserting a new row into the database. If you insert a new
Art sObject, you are creating a new entry in the "art" table in your project’s database.

13.26 Checkin

Checkins in Tactic is generally the process of placing and registering all of the files that represent a "snapshot" of that object.
This snapshot is a package in itself that understands all of the versioning and location for all files and/or folders that are a part of
that checkin.

With the notion of each Search Object being a container, creating snapshots can be compared to creating and storing packages in
this container.

From the back-end of Tactic the great aspect of this process is that this package is simply meta data that points to where the
actual files and folders live in the file system. The main benefits of this that if Tactic we to be shut off, the files system will still
be available and very well organized.
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